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LIMDEP 
 

 

LICENSE AGREEMENT 

 

 You have only the non-exclusive right to use this computer program.  You may use the program on 

a single computer at any one time.  If necessary, you may make one copy of this program for backup in 

support of your own use on the single machine.  This program and manual may not be distributed to any 

other party.  This program may not be electronically transferred from one computer to another or over a 

network without specific authorization by Econometric Software, Inc.  You may not modify, adapt, translate, 

or change the program or the manual without prior written permission of Econometric Software, Inc. 

 

 

DISCLAIMER OF WARRANTY 

 

 This program is provided ‘as is’ without warranty of any kind.  You are responsible for the choice of 

this program and for all results obtained with it.  Econometric Software shall have no liability or 

responsibility to the purchaser or any other entity for loss or damage alleged to be caused by the use of this 

program or its documentation.  This disclaimer of any liability shall include, but is not limited to, any loss of 

business, savings, or profits, or any other incidental or consequential loss or physical damage resulting from 

use of this program or its documentation. 

 

 

DEFECTIVE MEDIA REPLACEMENT 

 

 The media on which LIMDEP is provided are warranted to be free of physical defects in material or 

workmanship  in normal usage and will be replaced without charge if such physical defects are reported to 

Econometric Software, Inc. within thirty (30) days of the date of purchase. 
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Preface 
 

 

 LIMDEP is a flexible computer program for estimating the sorts of models most frequently analyzed 

with cross section data.  Its range of capabilities include basic linear regression and descriptive statistics, the 

full set of techniques normally taught in the first year of a graduate econometrics sequence, and many 

advanced techniques such as nested logit models, parametric duration models, Poisson regressions with right 

censoring and nonlinear regressions estimated by instrumental variables and the GMM.  LIMDEP's menu of 

options is as wide as that of any other general purpose program available, though, as might be expected, 

longer in some dimensions and shorter in others (notably time series analysis).  This is not an all purpose 

program which will solve every imaginable problem.  In spite of claims to the contrary, that program does 

not exist.  If it did, it would be impossibly cumbersome.  Rather, our guiding principle in the construction of 

LIMDEP is a desire to make as many of the widely used techniques and nonlinear models as simple to apply 

as possible.  LIMDEP is best suited to the analysis of cross sections and relatively standard problems of time 

series analysis, such as ARMAX models, distributed lags, and low order autocorrelation. 

 This program has developed over many years (since 1980), initially to provide an easy to use tobit 

estimator - hence the name, ‘LIMited DEPendent variable models.’  The accumulated suggestions of many 

colleagues, students, and users too numerous to thank individually have led to the current package.  In 

particular, the help of Aline Quester, Nathaniel Beck, Andrea Long, David James, Bill Spitz, Charles 

Hallahan, Terry Seaks, Rich Goldstein and Steffen Kuehnel has been considerable.  Version 7.0 continues 

our periodic cycle of collecting, then incorporating the many suggestions we receive from our users.  We 

also update LIMDEP every few years to incorporate new developments in econometrics and to meet the 

changing demands of our users. 

 Version 7.0 also reflects the major participation of David Hensher and Michael Lowe at 

Econometric Software, Inc., Australia.  The Windows 95/NT version of LIMDEP was developed in 

collaboration with Michael Lowe. 

 To the best of our knowledge, the code of this program is correct as described.  However, no 

warranty is expressed or implied.  Users assume responsibility for the selection of this program to achieve 

their desired results and for the results obtained. 

 

William H. Greene 

Econometric Software, Inc. 

15 Gloria Place 

Plainview, New York  11803 

January, 1998 
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Preface to Version 7.0 
 

 

 Version 7.0 of LIMDEP continues our efforts to produce major upgrades to the program while 

maintaining compatibility with earlier versions.  Version 7.0 features a new set of estimation programs 

including NLOGIT, an optional FIML estimator for nested logit models, enhanced capabilities, a 

redesigned interface and, with this revision, full conversion to the Windows 95/NT operating system. 

 

Revised Interface 

 Current LIMDEP users will see vast improvements in LIMDEP’s interface, such as: 

 

 •    Conversion of the user interface to the Windows 95/NT operating systems 

 •    Redesigned screens for input and output 

 •    Greater use of menus and function keys 

•    Expanded HELP and a slightly abbreviated manual which is now in the help file. 

 •    Greater use of algebraic syntax in mathematical commands (e.g., b'x instead of Dot(X,b).) 

 •    Full use of algebra in all logical expressions 

 •    More informative diagnostics and a complete trace of execution, with diagnostics and 

        indexation of commands to the output file 

 •    Improved formats in all program output 

 •    A program for constructing output tables of several sets of estimates 

  

New Models 

 Version 7.0 features the following new estimation programs: 

 

 •    Nested tobit models 

 •    Grouped data models with sample selection 

 •    Count data models with altered probability of the zero outcome 

 •    Count data models with sample selection  

 •    Bivariate probit models with heteroscedasticity 

 •    Multivariate and multinomial probit models 

 •    Random coefficients models 

 •    Partial observability models 

 •    Nonlinear multiple equations models and GMM estimators 

 •    Bivariate tobit model 

 •    Random effects tobit, probit, and logit models 

 •    Fixed and random effects models for count data 

 •    Random parameters logit model 

 •    Models of heterogeneity and underreporting for count data 

 

In addition to the new estimators, many new features have been added for manipulating panel data.  With 

Version 7.0, all data panel models may be based on unbalanced data sets. 
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Nested Logit Models 

 NLOGIT is a full information maximum likelihood estimator for two to four level nested logit 

models.  This full-featured, extremely flexible estimator is, to our knowledge, the only FIML estimator of its 

kind available as part of an integrated econometrics package.  Users of NLOGIT will have all of LIMDEP’s 

functions available to them.  NLOGIT is an optional feature of LIMDEP 7.0 and is sold separately. 

 

New Programming Features and Tools 

 Version 7.0 offers added power and enhanced capabilities to existing commands as well as new 

programming features such as: 

 

 •  Completely revised and simplified matrix algebra program 

 •  Subroutines with parameter lists 

 •  Loops using DO FOR, DO WHILE, and DO UNTIL 

 •  Indexation of variables in lists for looping over a set of variables 

 •  Revisions of the editor 

 •  Major enhancements to MINIMIZE 

 •  Bootstrapping and subsampling 

 •  New commands for analyzing model results such as restrictions and hypothesis tests. 

 

Marginal Effects 

 The computation of marginal effects has been automated for all of the limited and qualitative 

dependent variable models.  This will eliminate the large amount of effort that was needed to obtain partial 

effects in models such as the multinomial logit, sample selection, and various probit models.  With the 

addition of ;Marginal Effects to the model command, you will now obtain a full set of statistical output 

(identifier, estimate, P-value, and t-ratio) for all estimated marginal effects computed at the overall sample 

means and at the means of additional strata that you may specify. 

 

Constraints and Tests 

 All models estimated with LIMDEP may now be specified with equality and fixed value restrictions. 

 The ;Rst=specification feature that was introduced in Version 6.0 to allow cross equation equality 

restrictions in the multinomial logit model has now been extended to all of the other nonlinear models in 

LIMDEP’s menu.  This option allows you to force coefficients in a model to equal other coefficients or to 

take fixed values rather than be estimated. 

 LIMDEP contains many tools for carrying out hypothesis tests, including Wald, LM, and LR tests.  

The programming features now make it easier to carry out tests of nonnested hypotheses.  Version 7.0 

provides a new feature that will allow Wald tests of any number of sets of linear or nonlinear restrictions of 

the parameters of any model.  Every model command can be followed immediately by as many WALD;... 

restrictions$ commands as desired.  A standard set of labels is provided which makes them simple to use 

and invariant to the model specification.  (Version 6.0’s ;Test option requires that parameters be identified as 

B(j) where j is the position of the parameter in the coefficient vector.  Thus, if the specification changes, so 

must the restriction.  In Version 7.0, coefficients are denoted B_name, where ‘name’ is the name of the 

variable multiplied by the coefficient.  This does not change from one model to another.) 
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Incompatibilities Between the Windows and DOS Versions 
 

 

 There are a number of  major differences between the Windows and DOS versions of LIMDEP 7.0, 

including, of course, the obvious change to a screen, menu oriented interface.  But, we emphasize that the 

differences that do exist concern only how instructions are given to the program.  There are no differences in 

the statistical capabilities of the two programs or in their other data manipulation routines.  In general, many 

options exist in the Windows program that are not available in the DOS program.  In addition, some of the 

commands in the DOS program are absent from the Windows program, or are handled in a different fashion. 

 The following lists the major differences in the basic operation of LIMDEP: 

 

• DEMO:  The Windows program does not contain the demonstration. 

• DISK:  Features of the file system are handled using Windows’ standard features 

• EDIT:  The screen text editor in the Windows program replaces the DOS command prompt. 

• EXTRACT:  Large data sets are no longer handled with temp files.  (See Chapter 5.) 

• LOAD/SAVE:  These work as before, but operate more easily in the File menu. 

• PAUSE:  Output is accumulated in the output window, and can be reviewed as desired. 

• PRINT:  Data listings should be sent to a file, then printed later if necessary. 

• RESET:  This operation is handled with the Project menu. 

• REVIEW:  This command is now available in the Tools menu. 

• SHOW:  You can bring a file into the editor, but better to switch to another window. 

              To SHOW a file, just use File:Open in the main screen menu. 

• STATUS:  Operation of the project window replaces this function.  (See Chapter 3.) 

• STOP/EXIT/QUIT:  Select File:Exit to leave LIMDEP. 

• SYSTEM:  You can just open a DOS window for this function. 

 

This manual contains separate instructions on operation of the two programs.  Other differences between the 

Windows and DOS programs are described in Chapters 2 and 3.  A full summary of the Windows menus is 

given in Section 3.10. 
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Incompatibilities Between Versions 6.0 and 7.0 
 

 

 Version 7.0 is nearly fully backward compatible with Version 6.0.  The only substantive difference 

is in the matrix commands listed below, though users of the bivariate probit model should make note of the 

change in the way that fitted values are computed for this model.  Users of Version 6.0 may note that SAVE 

files written by Version 7.0 are far smaller than their Version 6.0 counterparts.  This is due to a much more 

efficient way of storing the information.  Nonetheless, SAVE files written with Version 6.0 can be read by 

Version 7.0.  We do suggest that Version 6.0 SAVE files be recreated with 7.0, as some additional 

information is being placed in the newer files.  (Of course, SAVE files written by Version 7.0 cannot be read 

by Version 6.0.) 

  

Matrices 

  In matrix commands and programs, a matrix that is specified by enumerating its elements must now 

be enclosed in square brackets, i.e., ‘[...].’.  This applies to both sets of numbers which comprise matrices 

and to sets of matrices which comprise partitioned matrices.   For examples, 

  

 MATRIX ; A = 1,2 / 3,4 $ must now be MATRIX ; A  =  [1,2 / 3,4 ] $ 

 and MATRIX ; A = M11/M21,M22 $ must now be MATRIX ; A = [M11/M21,M22] $. 

  

Because of the variety of different arrangements that may appear, the effect of omitting the brackets is 

unpredictable.  In most cases, a diagnostic will appear, but in others, a matrix different from the intended one 

will be created without apparent error.  For instance, the first example above creates a 1H1 matrix containing 

1.0000. 

  

Panel Data Models 

  Frontier models with panel data previously used 
 

   ; Pds = T for fixed number of periods, 

  ; Lhs = Y,Ti for variable number of periods. 

 They now use  ; Pds = T where T is the fixed number of periods, 

or  ; Pds = Ti where Ti is the count variable for variable group sizes. 
 

This same syntax is also used for LOGIT, TOBIT, PROBIT, and POISSON.  Since none of these four 

commands with variable number of periods (or fixed for TOBIT and POISSON) were available in Version 

6.0, FRONTIER is the only command actually changed by this update. 

  Loglinear survival models (SURV ; Model = ...) with time varying covariates that were set up like 

panels were previously specified with 
  

  SURV ; Lhs = Time, Censor, Ti ; ... 
  

where Ti gives the number of records, which could vary by observation, or could be fixed.  This syntax is 

still supported, but users may use, instead, 
  

  SURV ; Lhs = Time, Censor ; Pds = T or Ti, 
  

where Ti may be a number if every observation has the same number of periods, or it may be a variable, 

used exactly the same as before. 
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Bivariate Probit Predictions 

  Predicted values for the bivariate probit model are computed as follows: 

 

  1.  Compute the four cells for the bivariate distribution based on b1′x1, b2′x2,D.  We then compute 

 

   P[y1=1,y2=1] = BVN(b1′x1,b2′x2,D) 

   P[y1=1,y2=0] = M(b1′x1) - P[y1=1,y2=1] = P[y1=1] - P[y1=1,y2=1] 

   P[y1=0,y2=1] = P[y2=1] - P[y1=1,y2=1] 

   P[y1=0,y2=0] = 1 - P[y1=1,y2=0] - P[y1=0,y2=1] - P[y1=1,y2=1] 

 

  2.  The prediction is then the (y1,y2) associated with the cell with the largest probability. 

 

In Version 6.0, the bivariate frequency distribution listed after the coefficient output was computed using the 

univariate probabilities.  I.e., If b1′x1 > 0, predict y1=1, and likewise for y2.  In Version 7.0, the bivariate 

distribution is used instead. 

  

SAVE Files 

  Version 6.0 provided a method of using a ‘SAVE’ file to store some intermediate results.  (See the 

Version 6.0 manual, page 60.)  In particular, this file allowed you to put in a file 

 

 1.  The listing of variables produced with the ;List option on model commands, 

 2.  The parameters and covariance matrices after estimation, and 

 3.  The raw second moments, means, standard deviations, covariance matrix, and 

       correlation matrix from DSTAT. 

 

This has been discontinued.  All of the results above can be placed directly into the output file. For 1, it is 

automatic.  For 2 and 3, simple MATRIX commands, with ;List will produce the same results.  The use of 

this type of file has been discontinued.  Note this not the file associated with the SAVE command discussed 

above. 

  

OR in Logical Expressions 

  In Version 6.0, the ‘+’ character was used to indicate ‘OR’ in logical expressions, such as 

CREATE;If(AGE=0 + INCOME=0)BADDATA=1$ in which BADDATA equals 1 if AGE equals 0 or if 

INCOME equals 0.  In Version 7.0, the operator ‘|’ is used instead.  Thus, the counterpart to the command 

above is CREATE;If(AGE=0 | INCOME=0)BADDATA=1$ 

  

BEEP and NOBEEP 

         The BEEP and NOBEEP commands have been dropped.  In addition, all beeping at the end of file 

entry, procedure entry, etc. has been discontinued.  (LIMDEP is quieter.) 
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Some Common Questions 
 

 

 The following are some of the questions most commonly asked about using LIMDEP: 

 

In reading a data file, LIMDEP claims to have reached the end of the file after reading exactly one half 

of the observations.  Why? 

 

1.  Your format statement is inadequate.  For example: 

 

  READ ; File = ... ; Nvar = 3 ; Format = (2F5.3) ... 

 

     This command reads three variables but gives only two format codes.  This requires 

     two lines of data per observation.  The second line is used to give the third 

     variable,  and one number is lost. 

2.  (Very unlikely)  You do not have a format statement.  But, the data file that you are 

     using has lines that are over 300 characters wide.  LIMDEP reads 300 characters.  

     If it does not find all of the values it expects, it goes to the next line. 

 

The iterations failed to converge.  A diagnostic stated that a minimum of the function could not be 

found. 

 This is common with models with correlation coefficients, such as the selection models and the 

bivariate probit models.  It should not happen with univariate probit or any kind of logit models.  It should be 

quite rare with LDVs such as the tobit model.  Check: 

 

 1.  Scaling the data.  Are the variables of very different magnitudes?  Try to avoid this.  This is 

especially problematic in routines that involve quadrature (random effects probit/ordered probit) 

and in routines that fit correlation coefficients (bivariate probit). 

 2.  Collinearity is also a problem in nonlinear models. 

 

 A strategy:  When you are having trouble estimating a model, try estimating it with a very small 

subset of the variables.  Choose one or two independent variables (for each equation if necessary) and 

estimate with just them (even if you do not believe the specification).  Build up the model from a small base. 

 When problems emerge, you will know where to look in the data. 

 

Why isn’t LIMDEP able to read my Excel spreadsheet file? 

 Current Windows versions of these programs write an enormous amount of superfluous (for our 

purposes) information into these files, and LIMDEP gets confused by it.  But, if you use either of these 

programs to create your data, at the time you wish to write the spreadsheet file, go to the menu of file types 

and choose the .WK1 format.  LIMDEP will be able to read the .WK1 file. 

 

The log-likelihood function for my model is positive.  Is this possible? 

 Log-likelihood functions are only required to be negative for models with discrete dependent 

variables.  Tobit models, regression models, duration models, etc. are based on continuous distributions.  

Thus, the log-likelihoods for these models can be positive. 
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During the iterations, I get a diagnostic that a variance (or standard deviation) is not positive or that a 

correlation coefficient is outside the admissable range (-1,+1).  Does this mean my estimates are not 

useable? 

 No.  LIMDEP searches for the maximizer of a log-likelihood by taking a step from a valid parameter 

estimate toward a new estimate.  If the new estimate is invalid, as in the query, LIMDEP issues a warning, 

then tries a shorter step.  If the iterations ultimately did converge, then the warnings can be ignored.  If 

convergence is not achieved, the warnings might be helpful in finding out why. 

 

The Cox proportional hazards model seems to take a very long time to iterate. 

 It does.  This model is extremely computation intensive.  Every iteration requires essentially N
2
 

passes through the data, not just one. 

 

Can I expand the data array? 

 For the DOS program, use a temp file.  You can in the mainframe version.  See the Appendix.  In 

the Windows program, you need only adjust the workspace to whatever amount of space you need.  The 

program handles everything else.  See Section 3.10.2. 

 

My computations require a matrix larger than 10000 cells. 

 Unfortunately, this limit is hard coded into LIMDEP.  On the other hand, you should never have to 

create a matrix whose length is the number of observations in the sample.  Chapter 10 contains extensive 

details on how to handle data matrices.  Chances are there is a way to do your computations without having 

to create a matrix this large. 

 

If you believe you have found a bug in LIMDEP, please do the following: 

 If it is something obvious, just write or call and let us know.  We’ll fix the program and send a 

replacement with alacrity.  But, it is much more likely that it will be something subtle.  For example, suppose 

LIMDEP crashed in the middle of an iteration because it tried to take the square root of a negative number.  

This sort of thing usually requires us to execute the program with your data and your commands.  Try to 

produce the error with as small a data set and command set as possible.  Send us enough material, including 

your trace file and the data, so that we can reproduce the problem.  When we find the problem, we'll fix it 

and replace your program.  Please try to avoid sending huge data sets.  Also, in almost  all cases, it is 

extremely helpful if you can send us the TRACE.LIM file that is associated with your problem run. 
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